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1. Prerequisites
In order to use the mk Motion Detector, the following hardware and software are required.

Hardware

• mk SD/HD camera and receiver

• Video capture card or external video capture device

• Fast PC (4/8 CPU cores, 4 GHz CPU frequency, 8 GB RAM, Windows 7/8/10 64 bit)

• nVidia CUDA-enabled graphics card

• Display with a resolution of at least 1440p.

Software

• Drivers for the video capture hardware

• Optional: 3rd party video capture software

• Drivers for the graphics card

• .NET 4.5 Runtime or higher

• mk Motion Detector application

2. Installation
Please refer to the „Quick Installation Guide“.

3. Language 
The language can be selected in the Help menu.

Page 3



Revision 3.0
mk Motion Detector

messtechnik
EMC Test and Measuring Systems

mk
Quick Start Guide

4. Capture Resolution and Frame Rate

Figure 4-1: Tab "Source" to setup and open a capture source

When the mk Motion Detector is started, it shows a settings panel to set up the video and audio source. Select the
device, resolution, frame rate and color scheme to use and click on the “Open” button.

It's also possible to load previously saved settings (see below).

Automatic updates, virus scanners and other applications should not be running during a motion detection 
measurement.

5. General Description
The mk Motion Detector application is used to detect motion in video streams, record video, and stream video to 
the network. A motion alarm is visually displayed and can optionally be output on different communication 
interfaces (TCP client, TCP server, COM port / USB). 

6. Motion Detector
The Motion Detector can be accessed by selecting the tab "Motion Detector" on the main tab panel at the top.

The Motion Detector can be configured with two sub-tabs. In the sub-tab „Regions Definition“ up to 16 regions of 
interest (ROIs), which will be processed, can be set up by drawing a frame for each ROI. The selected ROIs will be 
displayed in the sub-tab „MultiView“.

In order to maximize processing speed, the ROIs should be defined as small as possible!

Motion is defined as difference in the pixel values of two or more images. Which images are compared depends 
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on the algorithm. The output of the algorithms is a motion value which tells how many pixels have changed 
between the images compared. The value is given in per mill of the image area. This value is then compared to a 
min. and a max. user definable threshold. If the value is higher than the max. value or lower than the min. value, a
motion alarm is generated. After a motion alarm, no new alarm for that ROI will be generated for a customizable 
Alarm Duration. There’s also a second mode where an alarm is only generated when one of the thresholds is 
crossed with a customizable slope.

Figure 6-1: Tab "Motion Detector | Regions Definition" to define ROIs and get a full video view

If you click on the bottom left rectangle of an ROI’s yellow framing in Regions Definition, a context dialog appears, 
which contains settings for the ROI.  Name, detection Algorithm, highlighting of detected motion, Analyzer, the 
Pass Low and Pass High values, the Trigger configuration, and the Alarm Duration for each ROI can be configured 
(see Appendices A - E for additional information). ROI number 1 corresponds to detector number 1, ROI number 2 
corresponds to detector number 2 and so on.

When the actual detected motion is below the Pass Low or
above the Pass High threshold, a motion alarm is generated for
the corresponding ROI (see illustration) depending on the
Trigger configuration. After that, no new alarm will be generated
for that ROI until the defined Alarm Duration is over.

         

(red: alarm, green: no alarm)

Figure 6-3: Depiction of Alarm Thresholds
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The “MultiView” sub-tab shows the ROIs and their corresponding Status Displays. The ROIs can be arranged freely 
including overlapping. To tab through overlapping ROIs, hold CTRL+left click or hold CTRL+mouse wheel. 

In the Status Displays the current motion as well as the minimum and maximum values are displayed for each ROI.
As long as a motion alarm is active for an ROI, the corresponding Status Display is highlighted in red. When the 
Alarm Duration expires, the color changes back to yellow. Additionally, the detected motion is highlighted directly 
in the image pixels. The color and pattern of the highlighting can be configured in the ROI settings.

As long as at least one alarm is active for any ROI, the panel “Global Alarm” of the Motion Detector Control is 
highlighted in red. The Start/Stop button can be used to globally enable/disable motion detection and to reset 
statistics.

Figure 6-4: Tab “Motion Detector | MultiView” shows motion detection details and a multi video view

7. Recording and Streaming
In the Recorder tab the full video can be viewed and recorded while detection is done. The recording works 
independently of the Motion Detector (unless Alarm-triggered Recording is enabled). The target path and format 
of the video can be set through the Recorder Settings dialog accessible through the Recorder Control Panel or the 
Settings button in the Motion Detector tab. If an audio signal is present, it is included in the recording. The video 
can also be streamed to a network multicast address (e.g. 238.1.1.1:11000) and then the stream can be accessed 
within the same network (e.g. via udp://@238.1.1.1:11000).
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8. Triggered Recording
The mk Motion Detector provides an option to record video once a motion alarm is triggered. In order to activate 
the option, check “Triggered Recording” in the Recording Settings of the Motion Detector tab. After the 
measurement is stopped, video clips which show a recording of a definable interval around each alarm will be 
saved in the output directory. This way it’s possible to tell what triggered the alarm by reviewing the clips. Clips 
which overlap timely will be merged into one longer clip.

Figure 8-1: Settings for the Recorder

9. Image and Video Snapshots
Clicking on “Save Snapshot” saves the current frame including highlighted pixels to an image file into the output 
folder. If the option “Video Clip” in the section “On Button Press” is activated, a video clip around the alarm is 
saved too.
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10. TableView

Clicking on “Toggle TableView” of the Motion Detector brings up a table which shows details about each ROI. 
While no detection is running, settings can be adjusted. TableView also displays a  Live Chart of each ROI which 
shows a history of a configurable number of the latest motion values. While an alarm is active, the row of the 
corresponding ROI is highlighted in red.

It’s possible to sort rows by clicking on the header of a column and resize columns by draging the separator 
between two headers. Columns can be rearranged by drag & drop.

Right-clicking on a Live Chart brings up a popup from where it’s possible to save the current Live Chart to an image
or its values to a text file. You can also access settings for the chart.

By right-clicking on the Analyzer Selection, the settings for the selected Analyzer can be accessed. 
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Please refer to Appendices B and C for more information on available Analyzers and Analyzer Settings.
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11. Trigger Buttons
Optionally one ore more Trigger Buttons can be connected via a USB port or via TCP/IP, which are used to save 
snapshots or video clips (short press) or start/stop recording (long press). Please refer to the “dAV Trigger Button 
Guide” for details.

12. Communication
When selecting the File->Connections menu item, a new window opens where communication with external 
devices can be set up. You can set up the following communication modes:

TCP Client

The mk Motion Detector connects to a TCP server on a specific port. Start the external server, so that it waits for 
incoming TCP connections. Set up the IP address and the port of the server and press the connect button to start 
the connection. 

TCP Server

The mk Motion Detector waits for external TCP clients to connect. For that purpose the mk Motion Detector has a 
built-in TCP server which can be started by entering the port and pressing the Start button. Several clients can 
connect to a server. The IP addresses of all connected clients can be viewed in the output text box of the server. 

Serial Communication

An additional communication interface is the serial COM port. The protocol settings are fixed to 8-N-1 without 
handshake and the baud rate is selectable via a drop-down box.
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Figure 12-1: Settings for the different communication modes

Messages

By default, motion alarm messages are sent to all connected communication partners. E.g. the external TCP server,
all external TCP clients and serial COM port hosts are informed about a motion alarm. The alarm message has the 
following format: „MDX:EVENT <RoiInt> <ParamInt>“. For example, an alarm message for ROI number 3 would 
look like „MDX:EVENT 3 1“. This default “event-driven” mode can be changed to instead poll values from e.g. EMC 
software via the external interface. See the corresponding guide for the external interface for more information.

Message Description

MDX:EVENT <RoiInt> 
<ParamInt>

RoiInt: number of the ROI the alarm was detected in.
ParamInt: 0 … inactive, 1 … active

Message to IO module Setting can be used with an mk IO Module via network. The mk IO Module 
translates messages from the mk Motion Detector to electrical signals on output 
pins. The output pin is in state “high” while an alarm for an ROI is active. This 
function is only available in TCP Client mode.

In addition to sending alarm messages, the mk Motion Detector can receive and process commands. Commands 
which couldn't be executed as expected return one of the error codes shown below. Command processing is case 
sensitive and all commands must be sent in upper case! 

For a list of available commands please refer to Appendix F.
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Command Return Values Description

RES=00 Execution successful

RES=01 Execution failed due to an internal error

RES=02 Unknown command

RES=03 Wrong command parameter count

RES=04 Wrong parameter value

RES=05 Wrong parameter format

RES=06 Execution not possible in the current control state

RES=07 Required License missing in order to execute command

13. Saving and Loading Settings
All settings for the source, the Motion Detection, the Recorder and for communication can be stored in an xml file 
and also be loaded back into the application. For that purpose the File->Save Settings... or File->Load Settings... 
menu item must be selected. A dialog box will appear where the appropriate file can be selected. An existing 
connection to a source must be closed before new settings can be loaded.

If there is a file named “default_settings.xml”, the application will prompt you on startup if these default settings 
should be loaded.

Figure 13-1: Prompt to load default settings

Page 12



Revision 3.0
mk Motion Detector

messtechnik
EMC Test and Measuring Systems

mk
Quick Start Guide

14. Licensing

The mk Motion Detector software is protected with a hardware dongle. When starting the software and during 
runtime the dongle must be connected to the PC. If the dongle is disconnected you cannot use the software!

There are several license types / modules available:

• Permanent license: This license has no restrictions.

• Trial days license: You can use the software for a certain number of trial days. The trial days counter is 
activated when the software is launched for the first time.

• Expiration date license: You can use the software up to a certain date.

• Startup limit license: You can start the software a certain number of times.

When your license has expired, you can request a license update. You receive an activation 

key for updating your dongle license.

You can always get information about your current license via the Help->About menu.

Figure 14-1: About Dialog showing license information
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15. Appendix A: Available Motion Detection Algorithms
You can choose between the following detection algorithms:

Two Frames Difference

This is the simplest and fastest type. It compares two consecutive frames to each other. Thus fast motion can be 
detected. Static changes in the image may not be recognized as motion depending on the alarm thresholds 
specified.

Custom Frame Difference

This type compares the current video frame with a static user-defined frame. Thus also static changes in the image
(such as changing lighting conditions or changes in the background) can be detected as motion.

Differential Collins

This type compares the current video frame with both the previous frame and the frame before the previous 
frame. Only changes detected in both comparisons are registered as motion. This reduces noise getting registered 
as motion.

Background Modeling (MOG / MOG2)

This type works similar to Custom Frame Difference. It compares the current video frame with a stored 
background frame. In order to avoid motion alarms when the background changes slowly (e.g. getting dark), the 
background frame is adapted to the current scene from time to time.

Average Brightness

Instead of detecting motion, this detector computes the average brightness over an ROI and generates an alarm if 
it is outside the specified thresholds.

Simulator

Simulates a signal for when there’s no actual input signal available.
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16. Appendix B: Available Analyzers
You can chose between the following analyzers (parameters highlighted in italic):

Threshold

This basic analyzer generates a trigger if the current value is outside the interval specified by the Pass Low and 
Pass High values. The other analyzers automatically include the threshold analyzer and take the triggers generated
by it as inputs for more complex analysis. If the Threshold analyzer itself is selected, the trigger will generate an 
alarm directly.

Period

Monitors the time in milliseconds between two consecutive triggers. If the measured time is outside of (Period ± 
Tolerance X) an alarm is generated.

Frequency

Similar to the Period Analyzer, but monitors the time between the current trigger and the first trigger. If the 
measured time is outside of (n * Period ± Tolerance X) an alarm is generated.

Tolerance Band

This analyzer is in analogy to the trigger function of an oscilloscope. A reference can be teached for an arbitrary 
signal over the time window specified by the number of Samples of the Live Chart. After the reference is set, a 
following trigger will start a new “sweep”. If any value lies outside the Tolerance Band around the reference 
specified by Tolerance Y, an alarm is triggered. In this case Tolerance X is the number of neighboring reference 
values the current value is additionally checked against besides the reference value corresponding to the current 
value.

By setting the Hold-Off and Trigger Slope it’s possible to narrow down when triggers should be generated.

For a step-by-step example of analyzer usage and configuration see Appendix C.
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17. Appendix C: Analyzer Examples
For this example assume a periodic signal at 1 Hz, which will be produced for example by a blinking light using the 
Average Brightness Motion Detection Algorithm.

The Live Chart is set to contain 300 samples total, corresponding to 10 seconds or 10000 milliseconds at 30 fps.

Threshold

The thresholds are set to Pass Low = 0 and Pass High = 500 (corresponding to the half height of the chart). The 
threshold analyzer will generate a trigger every time the value is greater than 500.

Period

Set Period to 1000 ms, Tolerance X for example to 10 ms, Hold-Off to 400 ms, and Trigger Slope to Positive.

With these settings, a trigger is generated each time a new spike starts and the analyzer monitors if the triggers 
are (1000 ± 10) ms apart from each other.

Frequency

For this example, the same settings as for the Period Analyzer can be used.

Tolerance Band

Specify the width of the tolerance band by setting Tolerance Y to 10, meaning 10% of the max. possible value of 
1000. Set Tolerance X to 1 sample and Trigger Slope to Positive. Starting at 300 samples for the complete sweep, 
increase the Hold-Off until the next sweep triggers as desired.

For more information on how to set up the Tolerand Band analyzer please refer to the Tolerance Band Tutorial.
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18. Appendix D: ROI Shapes and Custom Masks
When defining ROIs it’s possible to use other shapes than just the standard rectangular shape. Elliptical/circular 
shapes can be defined by holding the CTRL key while dragging. More complex shapes like polygons or any freely 
drawn shape can be defined in the Mask Editor. To open it, hold the CTRL key and click on the bottom left 
rectangle of the ROI’s framing.

Anything highlighted defines the area which is monitored, while not highlighted areas won’t be monitored. If 
highlighting gets drawn or removed depends on the mouse button used (left mouse button ↔ draw, right mouse 
button ↔ remove).

The drawing of a rectangle or ellipse/circle can be aborted by pressing the mouse button you’re not holding while 
drawing the shape.

In order to draw a polygon, click the points where the edges should go and double click to finish the shape. 
Drawing of a polygon can be aborted by hitting the ESC key.
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19. Appendix E: Trigger Configuration
There are different modes for how triggers can be created by the motion detector. By default, when the actual 
detected motion is below the Pass Low or above the Pass High threshold, a motion alarm is generated. This is 
shown in Fig. 6-3.

A different mode can be activated by checking “On Threshold Crossing Only” and the according Trigger Slope in 
the ROI settings (Fig. 6-2). With this option, Triggers will only be created when the actual motion value crosses 
over one of the set thresholds and the value crosses out of the good range into the error range.

This behaviour is depicted in the following figures for the case when the tresholds Pass Low and Pass High are set 
to the same value (Fig. 18-1) or to different values (Fig. 18-2).
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20. Appendix F: List of Available Communication Commands

Command Description

MDX:START Create new log. Start alarms, logging, recording, and external events. 
Reset motion detectors. Reset motion statistics and alarms if preview is 
active.

MDX:STOP Stop alarms, logging, recording, and external events. Reset motion 
detectors, motion statistics, and alarms. Close log. Process audio/video. 
Allow user to change all settings.

MDX:PAUSE Pause alarms, logging, recording, and external events. Reset alarms. 
Allow user to change file prefix.

MDX:RESUME <Roi1Int> <Roi2Int> 
<Roi3Int> <Roi4Int>

Resume alarms, logging, recording, and external events. RoiNInt: 0 … no 
action for ROI #N, 1 … reset motion detector for ROI #N, 2 … reset 
motion statistics for ROI #N, 3 … reset motion detector and motion 
statistics for ROI #N.

MDX:RESUME <RoiIdInt> <ParamInt> Same as above for the ROI specified by <RoiIdInt>. No resets for the 
other ROIs.

MDX:RESUMEALL <ParamInt> Same as above with the same resume parameter <ParamInt> for all 
ROIs.

MDX:NAME FOLDER <FolderStr>
-or-
REC:NAME FOLDER <FolderStr>

Set new folder for log and recordings (only if STOPPED).

MDX:NAME FILESUFF <FileSuffixStr> 
-or- 
REC:NAME FILESUFF <FileSuffixStr>

Set new file suffix for recordings (only if PAUSED or STOPPED). Recording
file is stored in folder set by <FolderStr>, see above.
Example for name of recording file: 2018-5-28_15-20-
45_001_FileSuffixStr.*

REC:SNAPSHOT Save a snapshot of the current scene to the recording folder.

REC:START Start recording.

REC:STOP Stop recording.

REC:CLIP Save a video clip to the recording folder.

MDX:INIT Initialize polling mode for communication with EMC software. Disables 
sending of alarm messages and RES=XX acknowledge messages by 
default.

MDX:IDN? Send identification string.

MDX:ALARMCOUNT? Send number of alarms during the current measurement.

MDX:ALARMCOUNTID? <RoiIdInt> Send number of alarms during the current measurement in the ROI 
specified by its ID.

MDX:ALARMCOUNTNAME? <NameStr> Send number of alarms during the current measurement in the ROI 
specified by its name.

MDX:CURRENT? <RoiIdInt> Send the current motion value for the specified ROI.

MDX:MIN? <RoiIdInt> Send the minimal motion value of the current measurement for the 
specified ROI.
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MDX:MAX? <RoiIdInt> Send the maximal motion value of the current measurement for the 
specified ROI.

MDX:MEAN? <RoiIdInt> Send the mean motion value of the current measurement for the 
specified ROI.

MDX:MEDIAN? <RoiIdInt> Send the median motion value of the current measurement for the 
specified ROI.

MDX:LOGMESSAGE <MessageStr> Writes the specified message to the log file for later evaluation.

The following commands are deprecated and only included for backwards compatibility. It is not recommended to 
use these commands any more.

MDX:EMC32_INIT Same as MDX:INIT

MDX:EMC32_IDN Same as MDX:IDN?

MDX:EMC32_READ Same as MDX:ALARMCOUNT?

MDX:RESUME_ALL Same as MDX:RESUMEALL

REC:TIMESHIFT Same as REC:CLIP
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